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1.  Before You Begin

Welcome To Bid Express!

Bid Express is a secure information service that allows contractors to submit bids to state
transportation agencies directly over the Internet and provides access to a database of
historical bid data, proposal information, and bid letting schedules.

Bid Express saves the time needed for preparing bids on paper, and the travel time and
expense involved in attending lettings and submitting bids in person.  This valuable
service allows you to quickly scan all current lettings to find exactly the information for
which you are looking.  A search function is available for seeking keyword information
on current lettings, or historical data from previous lettings.  Plus, you have instant access
to lettings from across the country, not just those of your home state.

This information is provided to help you operate effectively and efficiently when using
the Bid Express service.

 Note:  This User's Guide was written for those who already have a Bid
Express account, have Expedite downloaded, and have created and
submitted a Digital ID.  Click on the Order Bid Express hyperlink on the Bid
Express home page (www.bidx.com) for information on how to create a Bid
Express account.  For more information about Expedite please see the
Getting Started Guide.  For more information about Digital IDs, please see
the Digital ID instructions.  Each of these documents is located in the
Members Only section of the Bid Express home page.

1.1  About This Guide
This User's Guide is divided into six chapters.

Chapter 2 explains general usage and features of Bid Express, and will help you become
familiar with the layout and functionality of the Bid Express Web pages.
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Chapter 3 provides information about the STATE DOT tab and the features it contains.

In Chapter 4, the LETTINGS tab is explained, including the different sections of a proposal.

The UTILITIES and SEARCH tabs are covered in Chapter 5.

Chapter 6 explains how to obtain Bid Express customer support.

1.2  The Help Button
The HELP button appears in the form of a question mark on a number of Bid Express
pages.  If you click on the question mark you are brought to a help section for that
particular page.  To return to the previous page, click the BACK button on your browser.

1.3  Documentation Conventions
This guide uses different techniques to help you identify important information.  Keys
that you press and buttons that you click to invoke an action are identified in small caps,
for example, “press the ENTER key.”  Tab names are also shown in small caps.

User entries (information you type in using the keyboard) are shown in bolded text.

Referenced publication titles and important terms are identified by italics.

 Note:  Important notes are indented from both the right and left margins and
flagged with small note icons.  Notes contain extra information that may help
you work more efficiently or understand a process more fully.

❢ Caution:  Cautions look very similar to notes, but are flagged with an
exclamation point icon.  Read all cautions; they contain important information
that should not be overlooked.

1.4  Getting Started
All you need to use Bid Express is a computer with access to the Internet.  Visit the Bid
Express web site at www.bidx.com and you are automatically logged in as a guest.  As a
guest, you will have access to most of the services available, although you will only be
able to access contracts with letting dates that have been posted for more than six months.
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Figure 1-1.  The Bid Express Home Page

Use the scroll bars to see the rest of the home page.  It includes more information about
Bid Express current events, plus a Members Only section.
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2.  General Usage and Features of Bid Express

Bid Express is designed for you to view an agency’s proposal and bid files, as well as to
download those files to your computer.  Although each agency has different workflow
and business rules, there are many common functions that apply to the entire Bid Express
system.

Figure 2-1.  The Bid Express Home Page

The Bid Express home page is divided into sections for easier navigation.

 Information about Bid Express, Frequently Asked Questions, the Privacy
Policy, and additional information can be accessed by selecting the
appropriate hyperlink the Information section, the left pane of the Bid Express
Web site.  This section is discussed in greater detail in Section 2.2.

 Use the Login box to access your Bid Express account.  You can also login
through the MYBIDX button.
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 The map area color codes the states that have Bid Express in production.
Clicking on a particular state brings you to the Bid Express pages for that
state.  Use of the Agency drop down list and the GO button can also bring you
to a state's Bid Express pages.

 The Latest Additions section has current information about Bid Express and
its features.

 You can find other news articles about Bid Express, Internet bidding, and
more in the News section.

 The Members Only section includes guides to help you use Bid Express.

At the top of the Bid Express home page are three buttons.

 The HOME button will always return you to this Bid Express home page.

 The MYBIDX button allows you to set up your account preference, and log into
and out of Bid Express.  This button is discussed in more detail in Section 2.4.

 The HELP button appears in the form of a question mark on a number of Bid
Express pages.  If you click on the question mark you will brought to a help
section for that particular page.  To return to the previous page, click the BACK
button on your browser.

2.1  Login
Before you can use Bid Express, you must log in.  Enter your Bid Express username in
the Login field on the Bid Express home page and press the TAB key.  Enter your
password in the Password field and click LOGIN.  This lets Bid Express recognize you as a
valid user of its services.

If you want to BidX.com to remember your password, activate the Remember My
Password checkbox before you click LOGIN.  This means that as long as you are still
connected to the Internet, you do not have to log into Bid Express again if you leave the
Bid Express site.

2.2  Information Section
Located on the Bid Express home page, the Information Section gives you access to
necessary Bid Express information that is not related to a specific state agency and is not
part of the bidding process.  The Information Section contains the privacy policy,
frequently asked questions (FAQ), the fee schedule, and other information.
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2.2.1  Order Bid Express

The Bid Express Subscriber Agreement and account ordering process are accessible
through the Order Bid Express hyperlink.

2.2.2 Bid Express Contacts

The Bid Express Contacts page lists the various ways of contacting Bid Express
administration and customer support.  There is also a list of agencies that are using Bid
Express.  At times, there may be other uses on this page, such as request for customer
feedback.

2.2.3  Frequently Asked Questions (FAQ)

The FAQ covers questions in six categories:  General Questions, Hardware/Software,
Digital IDs, Internet Bidding, Bid Bonds, and Fees.

Each category covers the frequently asked questions that relate to the heading.  If you
have a question in regards to Bid Express that is not covered in the FAQ, you can contact
Bid Express technical support.

2.2.4  About Bid Express

Click on the About Bid Express hyperlink to learn about Bid Express, how it relates to
Expedite, and a summary of the uses of Bid Express.  It also discusses Bid Express
reliability and the encryption technology used when submitting bids.

2.2.5  Privacy Policy

The Privacy Policy hyperlink brings you to the Bid Express Privacy Policy.  It explains
how the information you enter when you sign up for your Bid Express account is used,
and explains the use and function of a cookie.

2.2.6  Subscriber Agreement

The Subscriber Agreement describes the Terms and Conditions for using the Bid Express
service.  You must agree to the Subscriber Agreement before you register for a Bid
Express account.  The Subscriber Agreement also displays when you select the Order Bid
Express hyperlink on the Bid Express home page.

2.2.7  Acceptable Use Policy

The Acceptable Use Policy describes the kinds of conditions under which Bid Express
should and should not be used.
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2.2.8  Partners

The Partners hyperlink gives you information about other companies that work in
conjunction with Bid Express.  You can also go to the Web pages for these companies
from the Partners page, if applicable.

2.2.9  Fee Schedule

The Fee Schedule lists the cost of obtaining and maintaining a Bid Express account.  It
also explains the costs associated with a Digital ID, and how payments can be made for
using the Bid Express service.

2.2.10  BidX Alerts

The BidX Alerts page lists any issues between Bid Express, its related software, and
users' computers.  For example, users of XP may have more security issues than
Windows 2000 users.  This page addresses those issues.

2.3  The Map of the United States
In the middle of the Bid Express home page, there is a map of the United States.  States
that have Bid Express in production are indicated by a dark green color.  The pale-green
states are those which are not yet users of the Bid Express service.

To see the lettings for a particular state, click on that state on the map.  You can also
select the state from the Agency drop-down list and click GO.  This Agency drop-down
list also indicates which states are about to be in production with Bid Express.

2.4  MYBIDX - Setting Your User Options
Once you have successfully logged into the Bid Express Web pages, you can set your
account options.  To do this, click the MYBIDX button located at the top of the Web page.
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Figure 2-2.  Bid Express MYBIDX Button

 Note:  You can also log in to your Bid Express account from the Bid
Express home page.

The options available under the MYBIDX button are: Login, Logout, Preferences, and
Contact Information.

2.4.1  Login

You can use the Login hyperlink to log in to your Bid Express account if you didn’t log
in on the Bid Express main page.  Enter your Login name (Username) in the Login field,
and enter your password in the Password field.  Click LOGIN.  Once you are successfully
logged in, Bid Express returns you to the Bid Express home page.

2.4.2  Logout

When you have finished using your Bid Express account, you should log out.  This
disconnects your account from the Internet.  This is a security measure used so no one
can use your Bid Express account to get unauthorized information.

To log out of Bid Express, simply click the Logout hyperlink.

2.4.3  Preferences

You can set your Bid Express preferences, which include search records, contact
information, and a personalized address book.  To set these preferences, select the
Preferences hyperlink.  Once you have finished determining your preferences, click the
UPDATE button.
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Figure 2-3.  MYBIDX Button - Preferences

There are three different options under the Preferences heading.

Maximum Number of Search Records

Each time you search for a word or phrase on the Bid Express Web site, the number of
matches that are returned at one time is determined by this selection option.  The default
is 100.  If you feel this is too few a number, you can increase it; if it is gtoo many, you
can decrease it.  The fewer records you request, the faster the search takes.  Keep in mind
that you will see no more than the number selected, regardless of how many matches Bid
Express makes.  You can still find the records for which you are looking by specifying
additional search criteria.

Publish Contact Information

Your contact information is established under the Contact Information section.  If you
select Yes to the Publish Contact Information option, your contact information is
available to other Bid Express users.  This means that other Bid Express users can see
who you are and how to get in touch with you, using the information from the Contact
Information Section of the Contact Information page.  If you want this information to
remain private, select No.  The default is Yes.

Address Book

Your Bid Express address book is a convenient way to store e-mail addresses of others.
Select the Address Book hyperlink, and enter the name of the person for whom you wish
to create an entry in the Name field.  Enter that person's e-mail address in the Email
Address field.
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Figure 2-4.  Bid Express Address Book

Click the UPDATE ADDRESS BOOK button.  Bid Express will update the address book with
that information.

Once an address has been entered and the address book updated, Bid Express displays the
name and address with an envelope icon next to the name.  Now, when you want to e-
mail your contact, simply click the envelope.  Your e-mail application opens with the
address in the To field.

If you no longer need an address, click the Delete checkbox next to the address, then
click UPDATE ADDRESS BOOK.  That name and address will be deleted.

2.4.4  Contact Information

To change your Bid Express contact information, select the Contact Information
hyperlink.  This is where you can change your Bid Express login name and password.
You are also able to update your personal and business address, city, phone number, and
change how your name is displayed.  When you are done entering the new information,
click the UPDATE INFORMATION button.
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Figure 2-5.  Update Contact Information

You can change your login name and password on the Contact Information page.  Just fill
a new name or password in the Name or Password fields.  If you want your contact
information available for other Bid Express users, keep the default value of Yes for the
Publish Info field.

You can fill in as little or as much information as you want in the Contact Information
Section.  This information will be available to the other Bid Express users if you choose
to publish your contact information.

If your billing information changes, you can update it for Bid Express in the Billing
Address Section.

Once you are finished with the MyBidX page, return to the Bid Express main page by
clicking the HOME button.  Then select your state by clicking on it in the map of the
United States or by selecting it in the Production States drop-down list and clicking GO.
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3.  The STATE DOT Tab

The State's home page is the first one you see after you select the state on the Bid Express
home page.  The ST is replaced by the one or two letter abbreviation for the state (for
example, SCDOT for South Carolina Department of Transportation).  Other states may
have a different name for their transportation agency, so the DOT may be different as
well (for example, State Highway and Transportation Department).  Regardless of what
the abbreviation may be, the state's home page is referred to as the STDOT tab in this
document, and the state transportation agency is referred to as the DOT.

Figure 3-1.  STDOT Home Page

The title bar of the STDOT tab page displays the name of the DOT and the current time.
You must refresh your browser to keep the time current.

The STDOT home page is usually divided into two sections.  The first section displays any
messages created for the contractors by the DOT.  The second section, What's New, lists
any new information for any of the lettings.  Each section is dependant on information
from the DOT, and either one may not be available for your state.
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There may be times where Bid Express also posts a message to the contractors.  When
this happens, it will appear before any messages for the contractors by the DOT.

3.1  Messages From the DOT
The beginning of the STDOT tab displays any messages of which the DOT wants its
contractors to be aware.  The messages are displayed with the newest one first.  Each
message contains information that the DOT feels the contractor needs to know.  This can
include updates to bid items or a timeline for Internet bidding milestones.

3.2  What's New
Further down the state's home page is the What's New Section.  Use the scroll bars to see
this part of the page.

Figure 3-2.  STDOT Home Page - What's New

The What's New section contains information that has been posted specific to particular
letting dates.  The information only goes in the What's New section if it has changed from
when it was previously posted, or if it hadn't yet been posted.  When you click on one of
the hyperlinks under What's New, Bid Express opens the letting page where that
information resides.  From there, you can download or view the desired information.
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4.  The Lettings Tab

The LETTINGS tab displays every letting date since Bid Express has been active in that
state.  It also shows the current time.  You must refresh your browser to keep this time
accurate.

Figure 4-1.  The Lettings Tab

Each date corresponds to the letting information for that date.  There may be other
information on this page, such as in the above figure, but this information depends on the
DOT.

4.1  Viewing a Letting
Click on the desired date to see the letting for that date.
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Figure 4-2.  Contract ID Information for a Specific Letting Date

The letting page displays information specific to the letting, including the letting ID, the
number of proposals, and the time the bids are due.  It also has a section called Also
Available, which lists information specific to the letting, such as the eligible plan holders
and bid tabulations.  Underneath this information is a clock that counts down the time
until the letting.  You must refresh your browser to get the accurate countdown (unless
the letting has ended).  Last, we have the list of Contract ID, the call order for that
contract ID, and the county and description of the contract ID.

4.2  Also Available
On each lettings page is a section titled Also Available.  This section contains additional
information for the letting that is not a necessary part of the proposal.  This page differs
between each contract ID.

Some information allows you to download the file in either CSV (comma-separated
value) format or TSV (tab-separated value) format.

Not every file listed under the Also Available heading is listed in every state or for every
proposal.  There also may be files for your state that are not described in this document.
The available information on this page depends on the DOT.

4.2.1  Apparent Bid Results

This file shows the bids as read from the day of the letting.  The results show the apparent
winner, but the bids still need to be confirmed before the contract is awarded.

The Apparent Bid Results are only available after the letting had ended.
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Figure 4-3.  Apparent Bid Results

4.2.2  Bid Summary Results

The Bid Summary Results are the results of the letting after the opened bids have been
processed through Trns•port LAS.  A similar software program is used by those states
not using LAS.

The bid results are a more official representation of the winners than the apparent bid
results.

Figure 4-4.  Bid Summary Results
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4.2.3  DBE.bin File

The DBE.bin file contains a list of the Disadvantage Business Enterprises that have been
approved for use with the call order.  To use the list, download the DBE.bin file into the
Expedite Bid directory.  When you download a proposal that requires DBE information,
the DBE options appear on the Edit menu in Expedite Bid.

Once the DBE.bin file is in the Bid directory, start Expedite and open the proposal.
Select Add DBE Vendor from the Edit menu.  A window appears that allows you to
choose which DBE vendor to use for that item.  Repeat this command for each item with
which you want to use a DBE vendor.

Figure 4-5.  DBE Window in Expedite

 Note:  For more information about using DBE vendors in Expedite, read the
Expedite User's Guide or the Expedite online Help.

4.2.4  EBS and Amendment Files as an EBLIB File

You can download all files for a proposal into Expedite Bid using the EBS and
Amendments Files as an EBLIB file option.  Click the EBS and Amendments Files as an
EBLIB file hyperlink.  A window opens asking if you want to save the file to a disk or
open it.  Save it to a disk.

Once the file is saved, open Expedite Bid.  Select Open from the File menu.  Expedite
Bid opens an Open Proposal window.  Find the location of the saved file and click on it
once.  When the file name appears in the File Name window, click OPEN.
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Figure 4-6.  Expedite Open Proposal Window

Once you click OPEN, a Select Proposal window appears.

Figure 4-7.  EBLIB File in Expedite

Highlight the desired call order and click OK.  Once the proposal is downloaded, you
must download all amendments for that call order in sequential order.  You must repeat
this process for each proposal you are bidding on.

4.2.5  Proposal Data Below As Comma-Separated Values/Tab Separated
Values

Selecting this hyperlink allows you to download the proposal data for the selected letting
in either a CSV or TSV file.  Once this file is downloaded, you can view the proposal
data in a spreadsheet program, such as Excel.
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4.2.6  Notice to Contractors

The Notice to Contractors is a text file posted by the state agency to inform contractors
about details ranging from the location of the bid opening to causes for denying the
awarded contract.

Figure 4-8.  Example Notice to Contractors

4.3  Viewing a Contract
To view details regarding a specific contract, click the Contract ID.  A new page appears
containing specific contract information.
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Figure 4-9.  Contract Information

The Contract page displays a lot more detailed information about a contract than is
displayed on the list of lettings including the item number and description of the item.  A
Contract page also contains several links that allow you to view online reports such as the
specific Expedite information for the proposal or the eligible plan holders list.  These
online reports are contract-specific.

4.3.1  Amendment Files

Click on an amendment for a call order.  A window opens asking if you want to open the
file or save it to a disk.  Since amendment files have to be added to the call order through
the Load Amendment option in Expedite Bid, save the file instead of opening it.

Once the file has been downloaded, open the proposal in Expedite Bid.  To apply the
amendment to the file, select Load Amendment from the File menu and choose the
amendment file.  Expedite Bid applies the amendment to the proposal.

If there is more than one amendment for a call order, you must sequentially download
and apply each amendment to the call order.

 Note:  For more information about loading amendment files in Expedite Bid,
read the Expedite User's Guide or the Expedite online Help.

4.3.2  Bid Tabulations

Bid Tabulations display the item level prices of a bid.  You can view the bid prices and
total amounts in either comma-separated or tab-separated values.
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Figure 4-10.  Bid Tabulations

4.3.3  Eligible Bidders List

Click the Eligible Bidders hyperlink to display a list of the bidders that are eligible to bid
on the specific proposal.  These bidders have been approved by the state DOT.  You can
download this page of information in text format or csv.

Figure 4-11.  Eligible Bidders List
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 Note:  The Eligible Bidders information is DOT-specific.  If this information is
not available, then most likely your DOT has not yet released a
comprehensive list of eligible bidders.

4.3.4  Expedite Data File

The Expedite Data file is a proposal file that can be opened in Expedite Bid.  It contains
all the information included on the proposal page in an EBS file format.  Although
Expedite Bid is not necessary to use in order to use Bid Express, it does make submitting
bids easier.  Click on the Expedite Data File hyperlink.  Decide if you want to save the
file to your computer or open it directly into Expedite Bid.

If you decide to save it as a file, open Expedite Bid and open the file.  Expedite Bid
displays the data file.  If you open it directly into Expedite Bid, then Expedite Bid opens
with the file displayed.

The EBS file displays the items in the call order that appear on your screen when you
click on the call order for the letting.  You can fill in the blanks in Expedite Bid and then
send the bid submission to the DOT.

 Note:  For more information about editing a bid in Expedite Bid, read the
Expedite User's Guide or the Expedite online Help.

4.3.5  Plan Holders List

Click the Planholders hyperlink to display a list of companies that have obtained plans for
a proposal.  Not all plan holders are on the Eligible Bidders list.  You can also download
this information as a .csv or tab-separated value file.

Figure 4-12.  Planholder's List
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5.  The Utilities Tab and the Search Tab

The UTILITIES tab and SEARCH tab each display similar information regardless of for
which state you are submitting bids.  The SEARCH tab is exactly the same, but the
UTILITIES tab may have some addition information, depending on the state.

5.1  The Utilities Tab
The UTILITIES tab gives you access to common utilities needed to use additional
information posted to Bid Express.

Figure 5-1.  Bid Express UTILITIES Tab

The three utilities that appear on each state's UTILITIES tab are WinZip, Acrobat, and
Expedite.
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WinZip is a file compression and decompression utility.  If you have downloaded a file
with a .zip extension, then you need to "unzip" it using WinZip.  Clicking on WinZip
brings you to the WinZip Web site (www.winzip.com).  From there, you can download
WinZip.

Acrobat allows you to view files that have a .pdf extension.  This is a common format for
files placed on the Internet, and the software is free.  Clicking on Acrobat brings you to a
Web page (www.adobe.com) that has Adobe Acrobat ready to download.

Expedite Bid allows prime contractors to create electronic bid documents and submit
them over the Internet.  Expedite Bid is especially helpful when used with Bid Express.
State agencies can post proposals and amendments as Expedite Bid files to Bid Express.
Click the Expedite Bid link to download Expedite for use.

There may be other items listed on the UTILITIES tab, depending on your agency’s
preferences.  It is likely that you will need all items that your agency has listed.  It is
recommended that you download them as soon as possible.

5.2  The Search Tab
The SEARCH tab allows you to search the entire Bid Express database for a vendor or a
subscriber, or search the Bid Express state database for a bid tabulation or an item.

Figure 5-2.  Bid Express SEARCH Tab

To use the Search function, find the type of search you would like to run.  Once you have
determined whether you want to search for a bid tabulation, an item, a vendor, or a Bid
Express subscriber, click in the Keywords field for that search.
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Enter the keyword for which you are searching.  If you are searching for an item or bid
tabulation, also select the dates that you want the search to cover.  Once you've entered
the necessary information, click SEARCH.

When the entire list has been search, Bid Express displays the results.  If the results you
receive are not the ones you expected, try the search again using different words.  You
can change the number of results from your search using the Preferences option (see
Section 2.4.3).
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6.  Bid Express Customer Support

Bid Express customer support service is available from 8:00 a.m. until 7:00 p.m., EST.
During those hours, Bid Express Customer Support can be reached by dialing Customer
Support at (352) 381-4888.  After 7:00 p.m., a voice message can be recorded for
customer support.  A support specialist receives the message the morning of the next
business day and processes the call.

6.1  Normal Technical Support
Bidx.com first level support provides solutions to common Bid Express technical
questions from contractors and agencies, usually during the initial call.  If the first level
support specialist is unable to resolve the problem within 30 minutes of the initial call,
then the problem is escalated to a second level support analyst.  This support team works
towards a quick resolution and response to the customer.  On the occasion where a
support resolution takes longer than two hours, a member of the support team contacts
the customer with an estimated time of resolution.  Then, once the problem is resolved,
the customer is notified of the resolution.

6.2  Non-Qualified Support Topics
Bid Express technical support is limited to questions regarding the Bid Express service.
The following topics are not considered Bid Express technical support items and are
therefore not included in this technical support agreement.  Bid Express Customer
Support will be happy to work with the customer to try and determine if the problem is
one of the following topics.

 Trouble with Internet connections
These should be referred to your Internet service provider.
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 Expedite Technical Support (except Digital ID and Bid
Submission/Withdrawal)
These should be referred to the DOT Expedite Representative.

 Operating System questions
These should be referred to the operating system software vendors.

 Printing questions
These should be referred to the printer hardware manufacturer.

 Problems with the Web Browser
These should be referred to the Web browser software vendor.

 Forgetting Digital ID/Password
There is no known technical means of recovering or determining a Digital ID
passphrase or password.  A new Digital ID submission with any applicable
fees will need to be submitted.

If there any questions regarding Bid Express Customer Support, please send an e-mail to
Bid Express at customer.support@bidx.com, or call 352-381-4888.
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